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Anotace 

Diplomové práce je zaměřena na výpočty aerodynamických charakteristik závodního 

automobilu. Popisuje metodu sestavení CFD modelu s vyuţitím 3D scanneru ATOS a 

prostředí softwaru Pro Engineer. V průběhu vytváření této práce byly zjištěny vlivy 

přídavných aerodynamických prvků závodního automobilu na výsledné zatíţení náprav.  
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The main subject of this diploma thesis is computation of race car aerodynamics. It describes 

composition method of CFD model with utilization of 3D scanner ATOS and CAD software 

Pro Engineer. During creating this diploma thesis were found influences of additional 

aerodynamics components of racing car on globally axle loads. 
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1. Úvod 

Současné závody automobilů formulového typu jsou velice náročné odvětví motosportu, kde 

o vítězích a poraţených rozhodují zlomky sekund. Proto velmi záleţí na tom, jak jednotlivé 

týmy dokáţou připravit svůj vůz na nadcházející závod. Právě aerodynamika zde hraje 

klíčovou roli. 

Tradiční způsob řešení aerodynamiky nejen závodních vozidel, ale i letadel, ponorek apod. 

představují aerodynamické tunely. Se současnými pokroky v matematických modelech 

aplikací počítačové dynamiky tekutin (CFD) a markantního nárůstu výkonu výpočetních 

stanic je stále větší mnoţství součástí vozu vyvíjeno přímo v CFD softwaru. Tato varianta je 

výhodná jak z hlediska menší časové náročnosti, tak i z hlediska ekonomického, jelikoţ 

nejsou potřeba investice na výstavbu a provoz aerodynamických tunelů. V současné době 

výrobci osobních vozidel pouţívají obě metody, a to pro srovnání a posouzení kvality 

výsledků získaných CFD simulacemi. 

Cílem této diplomové práce je sestavení CFD modelu reálného závodního automobilu za 

účelem získání dat popisující zatíţení aerodynamickými silami. Tato práce vznikla ve 

spolupráci s Energetickým ústavem, odbor termomechaniky a techniky prostředí, jelikoţ 

disponuje dostatečně výkonným hardwarem pro náročné výpočty a hlavně má v oblasti CFD 

dlouholeté zkušenosti.   
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2. Teorie aerodynamiky vozidel 

Aerodynamika je část fyziky, konkrétně mechaniky, která se zabývá silovým působení na 

těleso obtékané proudem vzduchu. Aerodynamika se uplatňuje především v letectví, 

automobilismu a architektuře. 

Proudění vzduchu je relativní. To znamená, ţe na těleso působí stále stejné síly, pokud je 

těleso vůči okolí v klidu a vzduch kolem něj obtéká nebo naopak. 

Při obtékání těles proudem vzduchu se na jeho jednotlivých površích více či méně tento 

vzduch stlačuje a tím se vytváří nerovnoměrné tlakové pole, které způsobuje silovou 

nerovnováhu. Tlak vzduchu lze uvaţovat třemi způsoby: 

Statický tlak – lze naměřit u stěny tělesa, kde je nulová rychlost. 

Dynamický tlak – lze naměřit za pohybu vzduchu, souvisí s rychlostí proudění. 

Celkový tlak – za předpokladu ţe neuvaţujeme ztráty jej lze povaţovat za součet statického a 

dynamického tlaku. 

 

S rostoucí rychlostí proudění roste hodnota dynamické tlaku. Pokud je ofukované těleso 

asymetrické, proudění vzduchu kolem něj bude také asymetrické a na jedné straně bude 

rychlost obtékání větší neţ na straně druhé. Na straně s vyšší rychlostí bude vyšší dynamický 

a niţší statický tlak. Nerovnováha statického tlaku způsobí vznik aerodynamické síly. 

Aerodynamická síla značně ovlivňuje jízdní vlastnosti vozidla. V následujících kapitolách 2.1 

– 2.6 jsou shrnuty základní poznatky z publikace Race car aerodynamics: Designing for 

speed, autor Joseph Katz [1]. 

2.1 Trajektorie proudu, přilnuté a odtržené proudění 

Trajektorie proudu jsou křivky spojené s ilustrativním popisem pohybu tekutiny. Vizualizace 

trajektorií nehmotných částic proudu můţe být získána v aerodynamických tunelech 

vstřikováním částic kouře do proudícího vzduchu. Nicméně pokud vstřikované médium nemá 

stejnou hustotu jako proudící tekutina, potom se nemusí pohybovat přesně po proudnici, ale 

můţe docházet k drobným odchylkám trajektorie vstřikovaného kouře od skutečných 

trajektorií. Proto se v aerodynamických tunelech pouţívá obarvený kouř s fyzikálními 

vlastnostmi co nejvíce blízkými vlastnostem vzduchu.  

Pokud trajektorie proudu, která se nachází v blízkosti pevného povrchu (například karoserie 

automobilu), opisuje přesně tvar povrchu, pak se takovéto proudění nazývá přilnuté. Pokud 

trajektorie proudu tento tvar neopisuje, pak se jedná o proudění odtrţené. K odtrţenému 

proudění dochází většinou na zadní části vozidla, v místě, kde se odtrhává mezní vrstva. Jak 

uvidíme později, přilnuté proudění a bod odtrţení má vliv na aerodynamické charakteristiky 

vozidla, nebo jeho částí. 

http://cs.wikipedia.org/wiki/Fyzika
http://cs.wikipedia.org/wiki/Mechanika
http://cs.wikipedia.org/wiki/Letectv%C3%AD
http://cs.wikipedia.org/w/index.php?title=Automobilismus&action=edit&redlink=1
http://cs.wikipedia.org/wiki/Architektura
http://cs.wikipedia.org/wiki/Tlak
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Obr. 1. Ilustrativní popis přilnutého a odtrženého proudění 

2.2 Vlastnosti tekutin 

Síla potřebná k pohybu vozidla skrze vzduch, popřípadě zmenšeného modelu vozidla ve 

vodním tunelu, závisí na fyzikálních vlastnostech okolní tekutiny, především na teplotě, 

hustotě, tlaku a viskozitě. 

Viskozitu okolní tekutiny lze zjednodušeně definovat jako míru odolnosti proti pohybu 

(podobně jako tření). Vliv viskozity můţe být znázorněn na jednoduchém pokusu se dvěma 

deskami umístěnými ve viskózní tekutině, které se navzájem vůči sobě pohybují. Spodní 

deska je vzhledem k souřadnému systému v klidu, zatímco horní deska se pohybuje směrem 

doprava konstantní rychlostí. Částice tekutin v bezprostřední blízkosti desek inklinují 

k ulpívání na površích obou desek a mají relativní nulovou rychlost vzhledem k jednotlivým 

deskám. Vlivem pohybu horní desky vůči spodní a ulpívání částic tekutiny na površích, 

dochází ke smyku, a molekuly tekutiny jsou vzájemně nuceny k relativnímu pohybu. 

Pozorovateli stojícímu na spodní desce se zdá rychlost proudění na nepohybujícím se povrchu 

nulová a na pohybujícím se rovna rychlosti tělesa. 
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Obr. 2. Znázornění pokusu s viskózní tekutinou mezi dvěma deskami 

Odolnost tekutiny vůči smyku se projevuje jako smykové napětí, které je potřeba překonat, 

aby došlo k pohybu tělesa umístěného v dané tekutině. Velikost smykové síly SF  je dána 

rovnicí 1, 

SF V

A h
   

kde A je povrch horní desky, µ dynamická viskozita, V rychlost volného proudu a h je 

vzdálenost desek. 

Hodnoty hustoty a viskozity tří nejběţnějších tekutin při teplotě 20 °C a tlaku 101 325 Pa jsou 

uvedeny v tabulce číslo 1. Z hlediska aerodynamiky vozidel nás samozřejmě zajímají 

především fyzikální vlastnosti vzduchu. 

Tekutina Hustota ρ [kg/m
3
] Viskozita µ [N·s/m

2
] 

Vzduch 1,22 1,8 · 10
-5

 

Voda 998 1 · 10
-5

 

Motorový olej SAE 30 919 4 · 10
-5

 

Tab. 1. Hodnoty hustoty a viskozity pro tři různé tekutiny 

2.3 Mezní vrstva 

Pokud se vozidlo pohybuje vzduchem, potom jeho tvar ovlivňuje pohyb jednotlivých částic 

vzduchu tak, ţe jejich rychlosti jsou různé. Na jednoduchém příkladě lze znázornit rozloţení 

rychlosti. Tenkou desku vloţíme do proudu vzduchu paralelně s proudnicemi. V různých 

vzdálenostech od desky současně vstříkneme bodově kouř. Po krátké chvíli (1 sec) můţeme 

sledovat změnu polohy jednotlivých bodů.  

(1)
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Obr. 3. Rychlostní profil v mezní vrstvě 

Pokus jasně dokazuje nulovou rychlost proudění na povrchu tělesa. S rostoucí vzdáleností od 

povrchu se velikost rychlosti zvyšuje, aţ se nakonec ustálí na hodnotě rychlosti volného 

proudu (rychlost, která jiţ není ovlivněna viskozitou vzduchu). Tato tenká vrstva se nazývá 

mezní vrstva. Pro vozidlo pohybující se rychlostí 100 km/h je tloušťka mezní vrstvy několik 

milimetrů v blízkosti přední části vozu, několik centimetrů na střeše vozu. 

Rychlostní spád v mezní vrstvě se můţe měnit dvěma způsoby, podle toho rozlišujeme 

laminární a turbulentní mezní vrstvu. 

2.4 Laminární a turbulentní proudění 

Laminární proudění je proudění viskózní tekutiny, jehoţ proudnice jsou rovnoběţné a 

neprotínají se. Jednotlivé částice tekutiny se pohybují ve vrstvách, které se vzájemně 

neprostupují. Mezi jednotlivými vrstvami laminárního proudění se předpokládá existence 

vnitřního tření. 

Turbulentní proudění je proudění viskózní tekutiny, jehoţ proudnice se navzájem 

promíchávají. Jednotlivé částice tekutiny vykonávají kromě posuvného pohybu i vlastní 

obecný pohyb, který způsobuje vznik vírů. Rychlost částic v jednotlivých místech 

turbulentního proudění je různá, tzn., ţe turbulentní proudění je nestacionární. 

K turbulentnímu proudění dochází při dosaţení určité hodnoty Reynoldsova čísla. To je 

definováno rovnicí 2, kde V je rychlost proudění, ν je kinematická viskozita a d je 

charakteristický rozměr. 



Ústav automobilního  Jan Vančura 

a dopravního inženýrství 

 

 

Brno, 2008  14 

 

 

DIPLOMOVÁ PRÁCE 

Re
V d




  

Vzhledem k rozměrům dochází při obtékání vozidla vţdy k turbulentnímu proudění. 

Rychlostní profil v mezní vrstvě laminárního a turbulentního proudění je na obrázku 4. 

 

Obr. 4. Rychlostní profil v mezní vrstvě laminárního a turbulentního proudění 

2.5 Bernoulliho rovnice 

Tvar pohybujícího se vozidla způsobuje změnu směru a velikosti rychlosti proudění, coţ má 

za následek vznik aerodynamického zatíţení. Tlaková síla působí kolmo na povrch tělesa a 

přispívá jak k aerodynamické odporové síle, tak i k aerodynamickému vztlaku. V případě ţe 

uvaţujeme obtékaným tělesem vozidlo, hovoříme o přítlaku. Nutno poznamenat, ţe tlaková 

síla vzniká vně mezní vrstvy (rychlost v mezní vrstvě na povrchu vozidla je nulová). 

Aerodynamického zatíţení je závislé na rychlosti proudění v blízkosti povrchu obtékaného 

tělesa, která souvisí s velikostí tlaku na povrchu. Vztah mezi rychlostí proudění a tlakem pro 

ustálené proudění a ideální případ beze ztrát popisuje Bernoulliho rovnice: 

2

2

p V
const


   

Bernoulliho rovnice slouţí k porovnání rychlostí a tlaků ve dvou různých bodech 

jednodimenzionálního proudění. Pokud se jedná o spojité proudění s konstantní hustotou 

proudící tekutiny, lze Bernoulliho rovnici pouţít v kterémkoliv bodě proudění. 

2 2

2 2

A A B Bp V p V

 
    

  

(3)

(4)

(2)
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2.6 Obtékání kol automobilu, Magnusův jev 

Kola automobilu jsou jeden z důleţitých prvků ovlivňující celkovou aerodynamiku vozidla, 

obzvláště pak u závodního automobilu formulového typu s nekrytými koly. Je potřeba 

rozlišovat obtékání rotujících kol a kol stacionárních. Podle tohoto parametru lze rozlišovat i 

aerodynamické tunely, kde se povětšinou rotující kola zanedbávají. Takováto měření jsou pak 

zatíţena určitou chybou. Moderní aerodynamické tunely jsou však schopny měření 

aerodynamických zatíţení automobilů s rotujícími koly. Roztočení kol zajišťují válce buď se 

zámky proti vyskočení pneumatiky (obdobný systém jako válcová zkušebna brzd), nebo 

pomocí rotujícího pásu, který nahrazuje vozovku. Pás je vyroben ze speciálního materiálu a je 

odolný proti nabíjení statickou elektřinou. 

Obtékání kol automobilu lze dobře popsat obtékáním válce. Největší vliv na rozloţení tlaku 

na povrchu pneumatiky oproti dobře popsanému válci je přítomnost vozovky. Rozdíl mezi 

obtékáním válce ve volném prostoru a v blízkosti vozovky je znázorněn na obrázku 5. 

 

Obr. 5. Obtékání válce ve volném prostou (vlevo) a v přítomnosti vozovky (vpravo) [1] 

Rozhodujícím parametrem ovlivňující koeficient tlaku na povrchu kola, a tedy i koeficient 

vztlaku a odporu, je místo odtrţení přilnutého proudění. Zatímco u stojícího kola dochází 

k odtrţení volného proudu v místě úhlu θ ~ 160° (znázorněno na obr. 7), u rotujícího kola se 

proud odtrhává dříve, tedy úhel θ je vyšší. Odtrţení přilnutého proudění u stojícího a 

rotujícího kola s vozovkou je znázorněn na obrázku 6. Bod odtrţení má vliv na celkové 

rozloţení tlaku na povrchu kola, které je popsáno obrázkem 7.  

 

Obr. 6. Odtržení přilnutého proudění rotujícího (vlevo) a stojícího kola (vpravo) [1] 
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Záporná hodnota koeficientu tlaku stojícího kola na jeho horní straně způsobuje vztlak a na 

zadní straně zvyšuje odpor. U rotujícího kola dosahuje koeficient tlaku menších hodnot, na 

horní straně je dokonce kladný. Jev, kdy rotující válec způsobuje vztlak, v tomto případě 

přítlak, se nazývá Magnusův jev. Tento jev se vyuţívá například k pohonu lodí (obr. 8), anebo 

napomáhá zakřiveným trajektoriím baseballových a golfových míčků. 

 

Obr. 7. Rozložení tlaku na povrchu rotujícího a stojícího kola [1] 

 

Obr. 8. Flettnerova pokusná loď – poháněna Flettnerovým rotorem využívající Magnusův jev, 

výška válců je 18 metrů [13]  
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2.7 Soustava aerodynamických sil a momentů 

V předchozí kapitole byly popsány jednotlivé sloţky aerodynamického zatíţení. Jednalo se o 

tlakovou a smykovou sílu. Celková aerodynamická síla má obecný směr a velikost. Pro 

posouzení jejího vlivu na zatíţení vozidla je potřeba ji vhodně rozloţit. Nejčastěji ji 

rozkládáme do směrů os souřadného systému vozidla, jehoţ střed leţí v rovině symetrie vozu, 

v polovině rozvoru a v rovině na které stojí kola (viz. obr. 9). Jelikoţ nás zajímají velikosti 

aerodynamických sil vzhledem k těţišti, je nutné tyto síly přepočítat.  

Na základě výše popsaného vztaţného aerodynamického souřadného systému lze celkové 

aerodynamické účinky rozdělit do šesti sloţek, a to do tří silových a tří momentových. Silové 

sloţky jsou aerodynamický odpor působící proti ose X, aerodynamický vztlak působící v ose 

Z a aerodynamická boční síla působící v ose Y. Momentové sloţky se dělí na klopný, stáčivý 

a klonivý moment. 

 

Obr. 9. Soustava aerodynamických sil a momentů [3] 

Velikost aerodynamické síly je obecně úměrná druhé mocnině rychlosti relativního proudění, 

čelní ploše tělesa a bezrozměrnému součiniteli závislém na tvaru tělesa. Jednotlivé sloţky 

aerodynamické síly jsou dány vztahy, kde A představuje největší průřez čelní plochy vozidla: 

Aerodynamický odpor: 21

2
X XF c V A        

Aerodynamický vztlak: 21

2
Y YF c V A       

Aerodynamická boční síla: 21

2
Z ZF c V A       

(5)

(6)

(7)
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Jednotlivé sloţky aerodynamických momentů jsou dány vztahy, kde r je rozchod kol: 

Moment klonění:  21

2
Y MYM c V A l        

Moment stáčení:  21

2
Z MZM c V A l        

Moment klopení:  21

2
X MXM c V A r      

 

Místo dvou aerodynamických sil a jednoho momentu můţeme zavést reakce na kolech, která 

přenášejí aerodynamické zatíţení na vozovku. Na obrázku číslo 10 je znázorněno silové 

nahrazení vztlaku a momentu klonění. 

 

Obr. 10. Silová náhrada vztlakové síly a momentu klonění reakcemi v místech styku kol s 

vozovkou 

Pro jednotlivé sloţky reakcí aerodynamického zatíţení vztlaku a momentu klonění v kolech 

platí: 

(8)

(9)

(10)
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Vztlaková síla na přední nápravě: 
 

0

2

yz
zp

MF
F

l
   

Vztlaková síla na zadní nápravě: 
 

0

2

yz
zz

MF
F

l
   

Pro celkovou velikost reakcí v kolech od aerodynamického zatíţení je potřeba do rovnic 

dosadit moment klonění vzhledem k souřadnému systému polohy těţiště. Podle obrázku číslo 

11 platí: 

Moment klonění v těţišti:    
2

y y x z zT

l
M M F h F l



 
      

 
 

Pro celkovou velikost vztlakových sil pak platí: 

Celková vztlaková síla na přední nápravě:  
 yz T

zp z x

Ml h
F F F

l l l


 

    

Celková vztlaková síla na zadní nápravě:  
 yz T

zz z x

Ml l h
F F F

l l l


 

    

 

Obr. 11. Celkové zatížení vozidla aerodynamickými silami 

V rámci zjednodušení budeme dále uvaţovat pouze aerodynamickou odporovou sílu působící 

proti ose X a přítlak působící proti ose Z, jejichţ působiště leţí v těţišti, a jim příslušný 

moment klonění. 

Jednotlivým sloţkám aerodynamické síly lze přiřadit jejich koeficienty, které jsou definovány 

jako: 

21

2

x
x

F
c

V A 





 
21

2

z
z

F
c

V A 





 

(11)

(12)

(13)

(14)

(15)

(16)
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2.8 Aerodynamika osobních a závodních vozidel 

Základním rozdílem mezi aerodynamikou osobních a závodních vozidel jsou jejich hodnoty 

aerodynamické odporové síly a přítlaku. Zatímco u osobních vozidel se snaţíme dosáhnout co 

nejmenších hodnot aerodynamické odporové síly z důvodu maximálního vyuţití výkonu 

motoru a tudíţ i menší spotřeby paliva, u závodních vozidel se snaţíme dosáhnout co 

nejrychlejších časů na kolo, coţ úzce souvisí s jízdními vlastnostmi vozu, především 

průjezdem zatáčky. Pokud vozidlo projíţdí zatáčkou, působí na něj v místě styku pneumatiky 

s vozovkou třecí síla, která je reakcí síly odstředivé působící v těţišti a je úměrná velikosti 

normálové síly. Abychom mohli projet zatáčkou rychleji, potřebujeme přitíţit nápravy 

vozidla. Zvyšování hmotnosti vozidla je samozřejmě neţádoucí, jelikoţ nám narůstají 

setrvačné síly. Pouţití aerodynamických prvků zvyšuje přítlak, a tedy přitěţuje nápravy bez 

navýšení hmotnosti vozu, obvykle za cenu navýšení aerodynamické odporové síly. 

U prvních závodních vozidel, které jiţ byly konstruovány s ohledem vlivu aerodynamiky 

v jízdních vlastnostech, se konstruktéři snaţili pouze sníţit aerodynamickou odporovou sílu, 

coţ lze názorně vidět na voze Ferrari 500 F2 obr. 12 se kterým Alberto Ascari získal titul 

mistra světa v letech 1952 a 1953.  

 

Obr. 12. Ferrari 500 F2, vlevo Alberto Ascari, mistr světa v letech 1952 a 1953 

K největšímu rozmachu vyuţití poznatků z oboru aerodynamiky v oblasti závodních vozidel 

dochází v 70. letech minulého století, kdy přítomnost přídavných aerodynamických prvků 

v podobě křídel byla jiţ samozřejmostí. V roce 1977 byl poprvé pouţit obrácený profil 

předního křídla ve spojitosti s blízkostí vozovky (ground effect) a boční lišty urychlující 

proudění pod vozidlem, coţ mělo za následek razantní zvýšení přítlaku. Jednalo se o vozidlo 

Lotus Type 78 F1, s jehoţ modifikací Lotus Type 79 F1 o rok později vyhrál Mario Andretti 

světový šampionát vozů F1.  
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Obr. 13. Lotus Type 78 F1 s postraními pohyblivými lištami [14] 

Mezi další zajímavost ve vývoji aerodynamiky F1 patří bezpochyby pouţití silného 

ventilátoru, který způsoboval podtlak pod vozem. Do závodu F1 však tento vůz nikdy 

nenastoupil, a to z důvodu zákazu pouţití pohyblivých aerodynamických prvků. Ze stejného 

důvodu se přestaly pouţívat pohyblivé boční lišty. 

 

Obr. 14. Brabham – Alfa Romeo BT46B [14]  
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3. Modelované vozidlo 

Pro tuto diplomovou práci byla zvolena formule Ford 1600, kterou má k dispozici Ústav 

automobilního a dopravního inţenýrství. Jedná se o vozidlo z 80. let bez přídavných 

aerodynamických prvků s motorem z vozidla Ford Escort o obsahu 1600 cm
3
 a čtyřstupňovou 

bezsynchronní převodovkou značky Hewland. 

 Obr. 15. Modelované vozidlo Formule Ford 1600 

3.1 3D scanner ATOS 

3D skenery jsou zařízení slouţící k digitalizaci reálných objektů, měření a reverznímu 

inţenýrství. Technologie různých skenerů se velmi liší, jejich moţnosti mají různé technické i 

ekonomické limity. Mezi nejjednodušší a nejlevnější se řadí skenery dotykové, které jsou 

značně omezené rozměry reálného objektu, a to jak jeho případnou mohutností, nebo naopak 

drobnými detaily. Další skupinu tvoří skenery bezdotykové, které se dále dělí na aktivní a 

pasivní. Aktivní, ekonomicky náročnější jak pořizovací cenou, tak i náklady na provoz, 

pracují na principu triangulace. Naopak pasivní skenery pracující na principu stereoskopie 

jsou podstatně levnější. Jejich hlavní nevýhodou je především citlivost na intenzitu okolního 

světla, odlesky povrchu a u starších modelů také na barvu povrchu. 

ATOS I je mobilní bezdotykový aktivní optický 3D skener firmy GOM. Základním principem 

tohoto bezdotykového skeneru je vyuţití triangulace. Aktivní 3D skenery vyţadují dvě 

kamery snímající tutéţ scénu. Vzdálenosti jednotlivých bodů jsou získávány porovnáváním 

rozdílů mezi obrazy jednotlivých kamer. 
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3.2 Příprava kapotáže pro scanner ATOS I 

Jelikoţ skener ATOS I, který byl pouţit pro snímání povrchů reálného vozu, dokáţe skenovat 

jen bílé plochy, je nejdříve potřeba povrch kapotáţe nastříkat bílou barvou. K tomuto účelu 

lze pouţít speciální sprej, který je však pro velké plochy ekonomicky nevýhodný. Jako 

vhodné řešení se ukázalo pouţití směsi plavené křídy s denaturovaným lihem nanášeným 

lakýrnickou pistolí. Poměr plavené křídy a lihu je pro tento typ nanášení barvy 1:1. Před 

stříkáním je nutné povrchy karoserie kvalitně odmastit, povrchové pukliny nasáklé 

mastnotami je vhodné přelepit lakýrnickou páskou. Výhoda směsi lihu s plavenou křídou je 

především její cena a také snadná omyvatelnost.  

Dalším krokem nutným pro pouţití skeneru ATOS je nalepení referenčních bodů. Jedná se o 

samolepící černobílé kruhové štítky. Místo, kam chceme bod nalepit, musíme nejdříve očistit 

od křídy. Vzdálenosti mezi jednotlivými body by měla být 15 – 20 cm pro pouţitý největší 

objektiv. 

3.3 Snímání povrchů 

Vlastní snímání povrchů má několik pravidel. Před prvním pouţitím skeneru je nejdříve 

potřeba celé zařízení kalibrovat. K tomu slouţí kalibrační desky pro jednotlivé kombinace 

objektivů a kamer. Pro snímání všech ploch byly pouţity kamery s ohniskovou vzdáleností 

17mm a projektor s ohniskovou vzdáleností 35mm. Úhel kamer skeneru ATOS I je 30° a 

snímací vzdálenost 75cm. Před kalibrací je vhodné zaostřit obě kamery a nastavit světelnou 

citlivost na podmínky v místnosti kde se bude skenovat. První scan by měl obsahovat co 

nejvíce bodů, kaţdý další následující minimálně 4, z toho 3 z předešlých měření. 

 

Obr. 16. 3D skener ATOS s výpočetní stanicí v pozadí, skenovaná špice Formule Ford 
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Celý proces skenování spočívá v promítání a současného snímání černobílého rastru na 

povrch snímaného tělesa. Poté připojená stanice vyhodnotí získaný záznam, a provede 

výpočet polohy bodů a tvaru povrchu. U kaţdého měření se zobrazuje jeho chyba. Obecně 

platí, čím více bodů se nám podaří sejmout, tím je scan kvalitnější. Pokud stanice nerozpozná 

dostatečné mnoţství bodů, je moţné je přiřadit manuálně, avšak pouze pokud nejsou tyto 

body jiţ příliš eliptické. 

Po oskenování celého tělesa stanice přiřadí plochám návaznost a vyhodnotí celkovou přesnost 

součásti, kterou lze zobrazit v barevném spektru. Výsledná data lze exportovat ve formátu stl, 

nebo lze provést řezy geometrií, a ty poté exportovat ve formátu iges. 

 

Obr. 17. Znázornění přesnosti a návaznosti jednotlivých scanů, červená barva udává největší 

odchylky 
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4. Tvorba modelu v prostředí softwaru Pro Engineer WF3 

Pro vytvoření celkového modelu karoserie z jednotlivých částí bylo vyuţito částečné podélné 

symetrie vozidla, to znamená, ţe stačilo vytvořit pouze polovinu vozidla a ta byla následně 

zrcadlena.  

Jednotlivé díly byly vkládány jako součásti do sestavy tak, jak to umoţňuje program Pro 

Engineer WF 3. Důleţitým prvkem je vytvoření orientovaného souřadného systému, který 

definuje směry posuvu a otáčení součástí při vkládání a skládání k sobě navzájem. Tento 

souřadný systém by měl být volen jako hlavní souřadný systém, který bude exportován do 

softwaru pro výpočet proudění 

Zde se ukázalo jako méně vhodná metoda skenování jednotlivých dílů karoserie a jejich 

následné skládání aţ v modelovacím programu. Díly, které jsou na vozidle namontovány, jsou 

následně deformovány rámem vozu a různými systémy uchycení na rám vozidla. Tyto 

nepřesnosti byly následně odstraněny drobnými úpravami dílů v programu Pro Engineer 

s přihlédnutím ke skutečným rozměrům a tvarům sestavené karoserie. 

 

 

    

 

 

 

 

 

 

 

 

Obr. 18. Schematický postup tvorby CAD modelu z reálného vozu 

4.1 Import řezů z formátu STL 

Pro vytvoření modelu byla pouţita metoda sestavení ploch pomocí řezů získaných 

z naskenované geometrie. Řezy se vytvářejí pomocí příkazu Plane paralel section 

v příkazovém panelu Section, a lze je exportovat ve formátu iges, čehoţ bylo vyuţito. Při 

exportu je vhodné zvolit si souřadný systém, se kterým se bude následně dobře pracovat 

v prostředí programu Pro Engineer. Řezy jednotlivými rovinami exportujeme zvlášť z důvodu 

lepší přehlednosti.  

Vlastní import řezů je základním stavebním kamenem kaţdého dílu modelovaného vozidla. 

Provádí se zaloţením nového úlohy typu Part a následným pouţitím funkce Insert -> Shared 
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data -> From file. V zobrazeném okně zvolíme typ souboru iges a zadáme cestu 

k poţadovanému souboru. Tento postup je třeba provést pro všechny řezy. 

 

Obr. 19. Importované řezy z formátu igs v prostředí softwaru Pro Engineer 

4.2 Tvorba ploch jednotlivých dílů 

Jednotlivé díly kapotáţe vozidla jsou tvořeny plochami, které vycházejí z importovaných 

řezů. Výhodou softwaru Pro Engineer je právě modul umoţňující vytváření ploch pomocí 

křivek jiných formátů. Tento modul je zastoupen ikonou plochy v pravém panelu. 

Pro vytvoření plochy je nejdříve nutné nadefinovat její hranice a pomocné křivky, coţ se 

provádí příkazem Cretate curves. Přidrţením klávesy shift se pak kurzor při výběru drţí 

importovaných křivek. Vytvořené křivky lze později editovat funkcí Edit curves. Hranice 

ploch musí být tvořena vţdy čtyřmi křivkami, přičemţ musí tvořit uzavřený obrazec. 

Pomocné křivky je vhodné přidávat v blízkosti rádiusů, v místě sbliţování hraničních křivek a 

na místech vzniku velkých ploch.  

Vlastní plochu lze vytvořit dvěma způsoby, mezi nimiţ jsem neshledal mnoho rozdílů. První 

z nich je Create surface from boundary curves, která je součástí příkazů modulu Style. 

Nejdříve je nutné vybrat hraniční křivky, a potom řídící křivky. Druhá moţnost je Boundary 

blent tool, která je mnohem méně náročná na operační paměť a dokáţe vytvořit plochy 
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z hranice se třemi křivkami. Plochy vytvořené oběma nástroji jsou zcela kompatibilní a lze je 

dále navzájem upravovat, ořezávat a slučovat. 

 

Obr. 20. Výsledná plocha části kapotáže se sáním a výfukem formule Ford 

4.3 Sestavení objemového modelu 

Sestavení celkového modelu lze rozdělit do dvou částí. První zahrnuje vytvoření sestavy z 

jednotlivých dílů, druhá pak zacelení mezer a modelování kol, náprav a dalších objemových 

prvků. 

Zaloţení sestavy se provádí obdobně jako zaloţení nového dílu, tedy File → New → 

Assembly. První vloţený díl karosérie by měl mít vhodně definovaný souřadný systém. V této 

práci byl jako základní díl pouţil kryt motoru, jehoţ souřadný systém se stal celkovým 

souřadným systémem celého modelu. Vloţení jednotlivých prvků karoserie se provádí funkcí 

Insert → Component. Aby bylo moţné zajistit následné úpravy modelu, především vytvoření 

dalších objemových dílů, je nutné celou sestavu modelu převést do prostředí Part. K tomu 

slouţí nástroj Copy Geometry v nabídce panelu Insert → Shared data. Je vhodné zrušit 

zatrţení Publish geometry only, čímţ se zbavíme neţádoucí vazby mezi modelem v sestavě a 

novým modelem vozu v prostředí dílu. 

Pro export modelu vozidla do programu pro výpočet proudění a pro vytvoření dalších částí 

vozu, jejichţ geometrie nebyla získána pomocí 3D skeneru, je vhodný objemový model. Aby 



Ústav automobilního  Jan Vančura 

a dopravního inženýrství 

 

 

Brno, 2008  28 

 

 

DIPLOMOVÁ PRÁCE 

bylo moţné takový model vytvořit, je nutné veškeré plochy nejdříve spojit funkcí Merge. 

Důleţité je mít zvolenou podmínku Intersect, podmínka Joint neořízne přesahující plochy a 

mohou vzniknout štěrbiny, které zabrání vytvoření objemu. Jako vhodným nástrojem se 

ukázalo pouţití vykreslení volných hran View → Display Settings → Model Display → Shade 

→ With Edges. Správně uzavřený model by neměl mít ţádné volné hrany. Poté stačí funkcí 

Solidify v záloţce Edit vytvořit vlastní objem.  

Pro vytvoření kol a ramen náprav bylo pouţito základních funkcí objemového modelování. 

Jako problematické se ukázalo protnutí více ramen v jednom bodě, který náleţel povrchu 

modelu vytvořeného z ploch. Z tohoto důvodu se ramena modelu neprotínají v jednom bodě, 

ale jejich osy jsou posunuty o více, neţ je průměr ramen. Převodovka vozidla byla nahrazena 

kvádrem se zaoblenými hranami, podobně jako zpětná zrcátka sloţená z ořezaného a 

zaobleného kvádru, připojená válcem. Záhlavní rám byl pouţit z modelu rámu, který byl 

vypracován samostatně v rámci jiné práce. 

 

Obr. 21. Finální podoba CAD modelu bez přídavných aerodynamických prvků 

 

Export modelu se provádí do pracovního adresáře pomocí volby File → Save a Copy, 

v záloţce Type vybereme poţadovaný formát. Při exportu do formátu IGES vybereme vţdy 

poloţku Solids. Tak zbavíme model případných pomocných ploch, které vznikly při plošném 

modelování a nijak se nepodílí na objemu modelu.  
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5. Vytvoření CFD modelu 

V této práci jsou řešeny čtyři různé varianty modelu, jedna z nich s tvarovými úpravami. V 

následující části jsou však řešeny modely bez přídavných aerodynamických prvků s různým 

nastavením okrajových podmínek, konkrétně kombinace rotujících a stojících kol s průchozím 

a neprůchozím sáním a chlazením. Pro lepší přehlednost jsou názvy modelu s jejich 

okrajovými podmínkami uvedeny v tabulce 2. 

 

Název modelu Rotující kola Průchodné chlazení a 

sání 

Formule Ford All ON ANO ANO 

Formule Ford Kola ON ANO NE 

Formule Ford Sání, chlazení ON NE ANO 

Formule Ford s přídavnými aerodynamickými 

prvky 
ANO ANO 

Tab. 2. Názvy CFD modelů s jejich nastavením okrajových podmínek 

5.1 Přehled současných CFD softwarů 

Současné CFD softwary lze rozdělit do dvou skupin. První z nich jsou softwary komerční. 

Jedná se o produkty renomovaných firem, které nabízejí komplexní řešení s moţností 

dokoupení modulů pro specifické úlohy. Do této oblasti patří: 

 Fluent – nejrozšířenější a nejznámější CFD software 

 CFX – produkt z balíku Ansys 

 Star CD / CCM+ – produkty společnosti Adapco 

 CFDesign – jednoduchý intuitivní CFD software 

Druhou skupinu software tvoří free produkty pod licencí GNU. Jsou to plnohodnotné 

programy, které mohou bez problémů konkurovat komerčním produktům. Jejich největší 

výhodou je ekonomické hledisko v podobě nulových pořizovacích nákladů. Nevýhodou pak 

sloţitější instalace a vyšší nároky na uţivatele. Do této skupiny patří: 

 Open Foam 

 PAB3D Software 

 Mouser 

 Overture 

Pro vytvoření CFD modelu byl pouţit software Adapco STAR CCM+, který své úlohy ukládá 

do souboru *.sim. Umoţňuje taktéţ export úloh do souboru *.ccm, který pouţívá software 

stejného výrobce STAR CD. Export do formátu *.ccm je moţný aţ po vytvoření objemové 

sítě. Je potřeba si uvědomit, ţe Adapco STAR CCM+ není vybaven téměř ţádným 

modelářským nástrojem, proto importovaný model musí být konečným modelem pro 

poţadovaný výpočet. Program umí importovat širokou škálu datových formátů. V úvahu 

připadali především formáty *.stl a *.igs. Jako výhodným se nakonec ukázal formát IGES, 

STL lze sice bez problému importovat, ale následná úprava sítě vţdy vedla k neočekávanému 

konci programu z důvodu nedostatku operační paměti. 
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5.2 Import ploch z objemového modelu 

Import modelu se provádí buď jednoduchou volbou z menu File -> Import Surface, nebo 

pomocí ikony trojúhelníku v panelu nástrojů. Z nabídky moţností importu je vhodné vybrat 

záloţku One boundary for all faces. 

Síť načteného modelu lze zobrazit z nabídky Outline zatrţením poloţky Mesh. V záloţce 

Representation lze přepínat mezi zobrazením načtené sítě (volba Import) a sítě vygenerované 

(volba Remeshed Surface/Volume Surface). 

 

 

 

Obr. 22. Importovaná síť CFD modelu 
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5.3 Vytvoření hraničních křivek, nastavení povrchové sítě 

Povrchová síť modelu se vytváří výběrem nástroje Surface Remesher z nabídky příkazového 

stromu Continua → Mesh → Models. Aby mohly být kvalitně vysíťované ostré přechody 

z velkých ploch na mnohonásobně menší (např. přechod z kapotáţe na rameno nápravy, 

z převodovky na poloosu apod.), musí být vytvořeny hraniční křivky. Ty se tvoří příkazem 

Mark Edges z nabídky Regions → Body → Feature Curve → New Feature Curve. 

Tyto hranice se musí dále editovat a vybrat jen ty, které jsou potřeba. Pomocí nově 

vytvořených hranic se model rozdělí na jednotlivé plochy, pro které je třeba nadefinovat 

velikost elementů. Poté stačí spustit vlastní remesher. 

 

Obr. 23. Vytvořená povrchová síť CFD modelu formule Ford s hraničními křivkami 

a příslušnými detaily přechodu hustoty sítě 

Velikost elementu se definuje pomocí hodnot základní velikosti Base size a minimální 

hodnoty Minimum size. Pro definování jemnější nebo hrubší sítě na menších plochách se 

vychází z procentuálních nebo absolutních hodnot Base size a Minimum size.  Hodnota Base 

size je pro výpočet proudění modelu daných rozměrů 20 mm, Minimum size 5 mm. Na 

menších plochách ( radiusy kol, výfuk, zrcátka, ramena …) byla nastavena velikost prvku 

25% Base size a 10 – 20% Minimum size.  

  



Ústav automobilního  Jan Vančura 

a dopravního inženýrství 

 

 

Brno, 2008  32 

 

 

DIPLOMOVÁ PRÁCE 

5.4 Objemová síť 

Objemová síť vychází ze sítě povrchové. Na výběr jsou Tetrahedral mesher  tvořící 

tetrahedrální síť, Polyhedral mesher, který tvoří síť podobnou “kopacím míčům“ a Trimmed 

mesher, tvořící hexahedrální síť. Výběr mesheru se provádí obdobně jako u mesheru plošné 

sítě, tedy z nabídky příkazového stromu.  

 

Obr. 24. Jednotlivé objemové sítě softwaru Adapco Star CCM+ 

Z hlediska vybavení hardwarem je nejvhodnější polyhedrální síť. Tato síť vzniká stejně jako 

ostatní sítě ze sítě povrchové. Nejdříve je však vytvořena tetrahedrální síť a následným 

slučováním její buněk vzniká síť polyhedrální, čímţ lze sníţit výsledný počet buněk aţ o 

80%. Tento typ sítě je lepší i z numerického hlediska, výpočty s touto sítí jsou stabilnější. 

V současné době je však polyhedrální síť mladá, proto ji některé výpočetní softwary 

nepodporují. Pro dosaţení lepších výsledků výpočtu je vhodné rozdělit buňky objemové sítě 

v blízkosti povrchu formule do více vrstev. K tomu slouţí nástroj Prismatic Layer Mesher 

v nabídce Continua → Mesh → Models. Dosáhne se tím lepších výsledků. 

5.5 Rozměry tunelu, ředění objemové sítě 

Základní rozměry tunely byly voleny s ohledem na celkový počet vzniklých buněk. Jako 

optimální varianta se ukázal tunel s rozměry: 

Šířka:  15 m 

Výška:  5,5 m 

Délka:  55 m 

Z celkové délky 55 m je 15 m před vozidlem a 40 metrů za vozidlem, myšleno od počátku 

souřadného systému importovaného modelu. 

Z důvodu velkého mnoţství buněk (cca 80 mil.) při těchto rozměrech tunelu bylo nutné 

provést ředění sítě. K tomu slouţí nástroj pro vytváření oblastí, ve kterých lze měnit 

parametry sítě. Vzhledem ke tvaru tunelu byla pouţita série těles Brick z poloţky Tools → 

Volume Shapes. Vlastní nastavení parametrů sítě v nově vytvořených oblastech se provádí 

v menu Continua → Mesh → Volume Sources. Rozměry jednotlivých oblastí vzhledem 

k počátku souřadného systému a jim příslušné hodnoty velikosti elementu sítě jsou uvedeny 

v tabulce 3. Celkový počet buněk polyhedrální ředěné sítě klesl na cca 2 480 000. 
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  Souřadnice bodu 1 [m] Souřadnice bodu 2 [m] 
Velikost elementu 

[m] 
Oblast X Y Z X Y Z 

Brick 1 -12,5 -1,2 -0,42 2,5 1,2 0,8 0,05 

Brick 2 -16 -1,7 -0,42 3 1,7 1,3 0,1 

Brick 3 -20 -2,7 -0,42 4 2,7 1,8 0,2 

Brick 4 -25 -4,2 -0,42 6 4,2 2,3 0,4 

Brick 5 -30 -5,7 -0,42 10 5,7 3,3 0,45 

Brick 6 -42 -9 -0,42 16 9 6 0,5 

Brick 7 -16 -1,25 -1 -2 1,25 0 0,08 

Tab. 3. Rozměry a velikosti základního elementu oblastí pro ředění objemové sítě 

 

Obr. 25. Oblasti pro ředění objemové sítě 
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Obr. 26. Naředěná objemová síť v rovině vozovky 

5.6 Nastavení fyzikálního modelu, vytvoření výpočetních senzorů 

Nastavení fyzikálního modelu, v tomto případě proudícího vzduchu, se provádí přidáním 

poloţky Physics continuum z poloţky Continua. Vlastní nastavení je v poloţce Physics → 

Models. Jednotlivá nastavení fyzikálního modelu jsou uvedena v tabulce 4. 

Space Three Dimensional 

Material Gas 

Optional Physics Models Cell Quality Remediation 

Flow Coupled Flow 

Motion Stationary 

Equation of State Constant density 

Time Steady 

Viscous Regime Turbulent 

Turbulence Reynolds - Averaged Navier - Sokes 

Reynolds - Averaged Turbulence K-Omega Turbulence 

K-Omega Turbulence SST (Menter) K-Omega 

K-Omega Wall Treatment All y+ Wall Treatment 

Tab. 4. Nastavení fyzikálního modelu 
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Nastavení okrajových podmínek se provádí ve stejném menu jako nastavení sítě jednotlivých 

ploch, tedy Regions → Body 1 → Boundaries. Jednotlivé okrajové podmínky jsou uvedeny 

v tabulce 5. 

  Okrajová podmínka Hodnota okrajové podmínky 

Tunel vstup Velocity inlet 50 m/s 

Tunel výstup Pressure outlet 0 Pa 

Silnice Tangential velocity specification Vector -50 m/s 

Boky Symetry plane - 

Kola Wall rotation 200 rad/s 

Sani Pressure outlet 0 Pa 

Výfuk Mass flow inlet 0,14 kg/s 

Chladiče  Mass flow inlet 2,56 kg/s 

Vstup chlazení Pressure outlet 0 Pa 

Výstup chlazení Mass flow inlet 0,64 kg/s 

Tab. 5. Nastavení okrajových podmínek na jednotlivých plochách CFD modelu 

Výpočetní senzory je potřeba nastavit z důvodu sledování ustálení výpočtu, respektive 

rychlosti proudění. Rychlost proudění je vhodné kontrolovat v malém objemu s co nejmenším 

počtem objemových buněk. Nejvhodnějším místem pro posouzení kvality výpočtu z hlediska 

ustálení proudění je přibliţně 0,5 m za vozidlem. V této oblasti lze předpokládat turbulentní 

proudění a největší změny rychlosti. Pokud změna rychlosti mezi jednotlivými iteracemi 

v této oblasti je jiţ dostatečně malá, lze usoudit, ţe se rychlost ustálila i v ostatních místech 

modelu.  Dále je nutné sledovat ustálení vztlakové a odporové síly a velikost residuí. Ustálení 

rychlosti proudu s odporovou a vztlakovou sílou je nutnou podmínkou pro získání kvalitních 

výsledků. Podmínky pro posouzení dostatečné kvality výpočtu pro tuto diplomovou práci 

byly stanoveny na základě zkušeností zaměstnanců Energetického ústavu a jsou znázorněny 

v tabulce 6. 

Sledovaná veličina Mezní hodnota  

Residua < 10
-4 

Rozptyl rychlost proudění 0,1 m/s 

Rozptyl velikost odporové síly 1 N 

Rozptyl velikost vztlakové síly 1 N 

Tab. 6. Podmínky pro posouzení dostatečné kvality výpočtu CFD modelu 

Vlastní vytvoření senzoru probíhá v několika krocích. Nejdříve je potřeba vytvořit kontrolní 

objem, coţ se provádí funkcí Sphere section v menu Derived parts. Poté je nutné v menu 

Reports vybrat poloţku Velocity a v poloţce Parts vybrat vytvořený Sphere section. Poté stačí 

z nově vytvořeného reportu vytvořit grafické znázornění průběhu rychlosti v jednotlivých 

iteracích funkcí Create Plot from Report.  
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6. Výpočet a zhodnocení výsledků všech variant modelu vozidla 

bez přídavných aerodynamických prvků 

Výsledky získané simulací proudění v softwaru Star CCM+ jsou uvedeny v tabulce 7, 

hodnoty koeficientu aerodynamického odporu a vztlaku jsou pro porovnání v grafech 1.a a 

1.b. Moment klonění je vztaţen k počátku souřadného systému popsaného v kapitole 2.7. (v 

rovině vozovky, polovině rozvoru vozidla a v rovině symetrie). Z výsledků je patrné, ţe 

nejmenších hodnot aerodynamického odporu a vztlaku dosáhl model s rotujícími koly a 

průchozím chlazením i sáním. Model s rotujícími koly a neprůchozími chladiči a sáním 

dosáhl nejvyššího aerodynamického odporu, zatímco model se stojícími koly a průchozími 

chladiči se sáním dosáhl největších vztlaku. Z hlediska výpočtu nejlépe konvergoval model 

s rotujícími koly a průchozími chladiči se sáním, nejhůře pak model s rotujícími koly a 

uzavřenými chladiči i sáním, coţ je patrné z obrázku 36 na rozloţení tlaku v oblasti vstupu 

vzduchu do chladičů. Rozdíl mezi pravým a levým vstupem lze přisuzovat právě nedostatečné 

konvergenci úlohy, která přes 15000 iterací stále nepřesáhla hranici residuí 10
-4

. Rychlost 

v kontrolním bodě se měnila o 0,5 m/s, síla o 5 N, viz tab. 6.  

Rozloţení statického tlaku na povrchu karoserie a vizualizace proudnic jsou patrné z obrázku 

27-36. Pro další výpočty zatíţení náprav byly pouţity střední hodnoty výsledků CFD 

simulací. 

Název modelu FX [N] FZ [N] MY [Nm] CX CZ A [m
2
] 

Formule Ford all ON -594,1 186,7 -361,7 0,492 0,062 0,816 

Formule Ford kola ON -643,3 243,6 -346,8 0,532 0,202 0,816 

Formule Ford chlazeni ON -608,5 347,1 -245,3 0,504 0,287 0,816 

Tab. 7. Výsledné hodnoty silového a momentového zatížení s koeficienty aerodynamického 

odporu a vztlaku variant CFD modelů bez přídavných aerodynamických prvků 

 

 Graf. 1.a a 1.b Velikosti koeficientů aerodynamického odporu a vztlaku pro jedntlivé modely 

bez přídavných aerodynamických prvků 
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Na následujících obrázcích je znázorněno rozloţení statického tlaku na povrchu vozidla 

formule Ford. Stupnice spektra barev a jí přiřazené hodnoty odpovídají přetlaku, popř. 

podtlaku vůči tlaku atmosferickému. Nulová hodnota na stupnici následujícíh obrázů tedy 

odpovídá tlaku 101 325 Pa, coţ odpovídá hodnotě atmosferického tlaku v nulové nadmořské 

výšce a teplotě 20°C.  

Pro následující obrázky tedy platí fyzikální vlastnosti vzduchu uvedené v tabulce 8. 

Fyzikální veličina Hodnota 

Hustota 1,18415 kg/m
3
 

Teplota 20°C 

Tlak 101325 Pa 

Rychlost 180 km/h 

Tab. 8. Fyzikální vlastnosti vzduchu platící pro výsledky znázorněných na následujících 

obrázcích. 

 

 

Obr. 27. Rozložení tlaku na povrchu vozidla bez přídavných aerodynamických prvků – šikmý 

pohled, perspektiva 
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Obr. 28. Rozložení tlaku na povrchu vozidla bez přídavných aerodynamických prvků – pohled 

seshora 

 

Obr. 29. Rozložení tlaku na povrchu vozidla bez přídavných aerodynamických prvků – pohled 

seshora, rozložení tlaku v rovině vozovky 
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Obr. 30. Rozložení tlaku na povrchu vozidla bez přídavných aerodynamických prvků – pohled 

zleva 

 

Obr. 31. Rozložení tlaku na povrchu vozidla bez přídavných aerodynamických prvků – pohled 

zleva, rozložení tlaku v rovině symetrie vozidla 
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Obr. 32. Rozložení tlaku na povrchu vozidla bez přídavných aerodynamických prvků – pohled 

seshora, vizualizace trajektorií proudu 

 

Obr. 33. Rozložení tlaku na povrchu vozidla bez přídavných aerodynamických prvků – pohled 

zleva, vizualizace trajektorií proudu, jejichž počátek leží v rovině symetrie vozidla 
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Obr. 34. Rozložení tlaku na povrchu vozidla bez přídavných aerodynamických prvků – čelní 

pohled, model Formule Ford All ON 

 

Obr. 35. Rozložení tlaku na povrchu vozidla bez přídavných aerodynamických prvků – čelní 

pohled, model Formule Ford chlazeni ON 
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Obr. 36. Rozložení tlaku na povrchu vozidla bez přídavných aerodynamických prvků – čelní 

pohled, model Formule Ford kola ON 

Z předchozích obrázků jsou jasně patrná místa s největším a nejmenším tlakem. Tlaková 

maxima leţí v místech čelních stran pneumatik, dále pak na čelních stranách zrcátek, 

záhlavního rámu, špice a hranách na vstupu do chlazení. U modelu s uzavřeným sáním (obr. 

36) lze pozorovat také maximum v místě vstupu do chlazení a vstupu do sání. Naopak minima 

tlaku se nacházejí na bočních hranách kol a přechodové části helmy a záhlavního rámu, tomu 

odpovídají a maximální hodnoty rychlosti proudění znázorněné proudnicemi v těchto místech. 

Z čelního pohledu je jasně vidět, ţe největší vliv na aerodynamický odpor mají právě kola a 

přilba. 
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6.1 Výpočet reakcí od aerodynamických účinků na nápravách modelů 

vozidla bez přídavných aerodynamických prvků 

 

  
Formule Ford All ON 

Formule Ford kola 

ON 

Formule Ford chlazeni 

ON 

Rozvor vozidla l = 2400 mm 

Vzdálenost zadní 

nápravy od těţiště lz = 919 mm 

Výška těţiště h = 250 mm 

Hmotnost vozidla s 

jezdcem m = 513 kg 

Aerodynamická 

odporová síla FX = 594,1 N FX = 643,3 N FX = 608,5 N 

Aerodynamická 

vztlaková síla FZ = 186,7 N FZ = 243,6 N FZ = 347,1 N 

Aerodynamický 

moment klonění MY = -361,7 Nm MY = -346,8 Nm MY = -245,3 Nm 

Tab. 9.a. Vstupní hodnoty pro výpočet zatížení náprav vozidla bez přídavných 

aerodynamických prvků 

Soustava rovnic pro výpočet silových reakcí: 

 

 

2
yT y X Z z

yTz
Zp Z G x

yTz
Zz Z G x

l
M M F h F l

Ml h
F F F F

l l l

Ml l h
F F F F

l l l

 
      

 

      


      

 

Výsledné hodnoty reakcí v místě styku kol s vozovkou jsou uvedeny v tabulce 9.b a v grafech 

2 a 3. 

  
Formule Ford All On 

Formule Ford kola 

ON 

Formule Ford chlazeni 

ON 

Výsledná celková 

reakce vozovky na 

přední nápravě 

FZp = 1682,0 N FZp = 1659,8 N FZp = 1650,3 N 

Výsledná celková 

reakce vozovky na 

zadní nápravě 

FZz = 3161,3 N FZz = 3126,6 N FZz = 3032,6 N 
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Procentuální zatíţení 

přední nápravy 
%FZp = 34,73% %FZp = 34,68% %FZp = 35,24% 

Procentuální zatíţení 

zadní nápravy 
%FZz = 65,27% %FZz = 65,32% %FZz = 64,76% 

Reakce vozovky od 

aerodynamických sil 

na přední nápravě 

FZpAero = -244,1 N FZpAero = -266,3 N FZpAero = -275,8 N 

Reakce vozovky od 

aerodynamických sil 

na zadní nápravě 

FZzAero = 57,3 N FZzAero = 22,7 N FZzAero = -71,3 N 

Tab. 9.b. Vypočtené hodnoty celkového a aerodynamického zatížení modelů formule 

bez přídavných aerodynamických prvků 

 

 

Graf. 2. Silové reakce vozovky na jednotlivých nápravách od celkového zatížení 
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Graf 3. Procentuelní rozložení celkového zatížení na nápravách modelů bez přídavných 

aerodynamických prvků při rychlosti 180km/h 

Statického zatíţení je rozloţeno v poměru 38,3% na přední nápravu a 61,7% na zadní 

nápravu, zatímco celkové zatíţení je rozloţeno v poměru 34,7% na přední nápravu a 65,3% 

na zadní nápravu u modelu s rotujícími koly a s průchozím chlazením a sáním. Z těchto faktů 

je zřejmé, ţe účinky aerodynamického zatíţení modelu bez přídavných aerodynamických 

ploch odlehčují přední nápravu a přitěţují nápravu zadní. Z hlediska velikosti aerodynamické 

vztlakové síly a celkového zatíţení náprav pak vyplívá, ţe aerodynamické síly působící na 

model bez přídavných aerodynamických prvků vozidlo odlehčují, coţ je samozřejmě 

nepříznivé. 

  

34,7

65,3

34,7

65,3

35,2

64,8

0

10

20

30

40

50

60

70

Za
tí

že
n

í [
%

]
Procentuelní rozložení žatížení na nápravách při rychlosti 

180 km/h

Formule Ford All ON přední náprava Formule Ford All ON zadní náprava

Formule Ford kola On přední náprava Formule Ford kola ON zadní náprava

Formule Ford chlazeni ON přední náprava Formule Ford chlazeni ON zadní náprava



Ústav automobilního  Jan Vančura 

a dopravního inženýrství 

 

 

Brno, 2008  46 

 

 

DIPLOMOVÁ PRÁCE 

6.2 Porovnání výsledků modelu vozidla bez přídavných 

aerodynamických prvků s měřenými hodnotami vozidla stejné 

kategorie 

Data získaná simulací nebylo moţno porovnat s ţádným měřením z aerodynamického tunelu, 

popř. z dojezdové zkoušky, jelikoţ nebylo v současné době na tomto vozidle ţádné z těchto 

měření provedeno. K porovnání tedy poslouţila data získaná z měření vozidel stejné 

kategorie, proto toto srovnání nelze povaţovat za směrodatné, ale pouze za orientační. 

 

Obr. 37. Velikost koeficientů aerodynamického odporu a vztlaku pro různé druhy závodních 

vozidel s nekrytými koly z roku 1985 [1] 

Z obrázku 37 je zřejmé, ţe modelovaná formule Ford je nejvíce podobná formuli číslo 2, jejíţ 

hodnota koeficientu aerodynamického odporu je 0,55 a hodnota koeficientu aerodynamického 

vztlaku je 0,25. Porovnáním těchto hodnot s daty získanými simulací se nejvíce podobají 

modelu s rotujícími koly a neprůchozím chlazením a sáním. Přestoţe je toto porovnání velmi 

hrubé, data získaná simulací jsou velmi podobná hodnotám vozidel stejné kategorie získaných 

měřením. 
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7. Návrh tvarových úprav 

Mezi tvarové úpravy modelovaného vozidla Formule Ford patří především vytvoření 

přídavných aerodynamických prvků v podobě předního a zadního přítlačného křídla. Nutnou 

podmínkou pro umístění zadního křídla do dané polohy byla změna polohy výfuku. Veškeré 

tvarové úpravy byly provedeny v softwaru Pro Engineer modifikací původního modelu. 

Výsledný CAD model je znázorněn na obrázku 38. 

 

Obr. 38. Výsledný CAD model formule s přídavnými aerodynamickými prvky vytvořený 

v softwaru Pro Engineer 

7.1 Vytvoření předního křídla 

Přední přítlačné křídlo bylo vytvořeno podle existujícího profilu AH 7-47-6. Jeho geometrie a 

hodnoty aerodynamického vztlaku a odporu byly získány z databáze softwaru Designfoil R6. 

Konečný návrh byl vytvořen v prostředí softwaru Pro Engineer. Celkem bylo vytvořeno 6 

variant výpočetních modelů, z toho jedna s křídlem na vozidle, dalších pět samostatně bez 

vozidla s různou vzdáleností od vozovky. U všech variant byl proveden výpočet proudění, 

zároveň byla získána závislost vztlaku, resp. přítlaku samostatného křídla na vzdálenosti od 

vozovky. Tato závislost je zobrazena v grafu 5.  
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 Graf 4. Rozložení koeficientu tlaku na profilu AH-7-47-6 předního křídla 

 

Obr. 39. Rozložení tlaku na povrchu předního křídla, šikmý pohled 
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Obr. 40. Rozložení tlaku na horní straně předního křídla 

 

Obr. 41. Rozložení tlaku na spodní straně předního křídla 
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Obr. 42. Rozložení tlaku v rovině symetrie předního křídla 

 

Obr. 43. Proudnice a velikost rychlosti proudění v rovině symetrie předního křídla 



Ústav automobilního  Jan Vančura 

a dopravního inženýrství 

 

 

Brno, 2008  51 

 

 

DIPLOMOVÁ PRÁCE 

 

Obr. 44. Vizualizace tří vrstev proudnic kolem předního křídla 

 

Obr. 45. Vizualizace proudnic kolem předního křídla v perspektivním promítání 
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Graf 5. Grafická závislost přítlaku předního křídla na vzdálenosti od vozovky 

Z předchozích obrázků je zřejmé rozloţení vyššího tlaku na horní straně křídla a podtlaku na 

straně spodní. Maximum tlaku leţí na horní straně náběţné hrany, minimum naopak na 

spodní straně náběţné hrany, coţ je patrné z obrázku 42. Bílé místo na tomto obrázku 

v oblasti minimálního tlaku vzniklo z důvodu mezních hodnot stupnice, konkrétně vyšší meze 

minima z důvodu lepší přehlednosti rozloţení tlaku. Z obrázků 43 a 44 je patrný nárůst 

rychlosti na spodní straně křídla a její pokles na straně horní. 

Ze série simulací s modelem křídla různě vzdáleného od vozovky byla získána závislost 

zobrazená v grafu 5. Z těchto výsledků vyplívá, ţe s přibliţováním křídla k vozovce narůstá 

velikost přítlaku. Ve skutečnosti tato závislost platí do určité hodnoty vzdálenosti křídla od 

vozovky při dané rychlosti. Poté je jiţ štěrbina tak malá, ţe dojde k omezení průtoku mezi 

spodní stranou křídla a vozovkou. Následkem toho dojde k poklesu přítlaku. Z tohoto důvodu 

je důleţité při nastavení výšky křídla zamezit dosaţení této vzdálenosti i při propruţení 

vozidla. 
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7.2 Vytvoření zadního křídla 

K vytvoření zadního křídla byly pouţity jiţ existující profily křídel. Geometrie v podobě bodů 

profilu ve formátu igs a hodnoty aerodynamického vztlaku a odporu byly získány z databáze 

softwaru Designfoil R6. Celkový návrh byl vytvořen samostatně v prostředí softwaru Pro 

Engineer, následně byl proveden i výpočet proudění kolem samostatného křídla. 

Výsledným návrhem pouţitým v této práci je dvouprvkové křídlo s přídavným spodním 

profilem pro vznik Venturiho efektu. Šířka křídla je 1000 mm. Jednotlivé profily křídel jsou 

popsány v tabulce 10. V grafu 7 je zobrazena geometrie křídla s rozloţením tlaku na povrchu 

při rychlosti volného proudu 50 m/s, zatímco obrázek 47 zobrazuje rozloţení tlaku v rovině 

řezu symetrie křídla. Grafické znázornění proudnic zadním křídlem je na obrázku 52, kde 

barevné spektrum zobrazuje hodnotu rychlosti. Na tomto obrázku lze pozorovat vznik 

vířivých proudů za křídlem. Obrázek 53 znázorňuje proudnice v rovině symetrie křídla. 

  Název profilu Úhel náběhu Štíhlost 

Spodní křídlo RG 14A – 1,4/7,0 3° 3,45 

Horní křídlo 
Whitcomb integral 

supercritical 
10° 4 

Přídavná klapka WB-135/35 50° 8,33 

Tab. 10. Profily jednotlivých prvků zadního křídla s jejich úhly náběhu a štíhlostí 

 

 

Graf 6. Rozložení koeficientu tlaku na profilu Whitcomb Integral Supercritical předního 

křídla 
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Obr. 46. Rozložení tlaku na povrchu zadního křídla 

 

Obr. 47. Rozložení tlaku v rovině symetrie zadního křídla, Venturiho efekt mezi horním a 

spodním profilem zadního křídla 
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Obr. 48. Rozložení tlaku na povrchu zadního křídla – pohled seshora, profily horního křídla a 

přídavné klapky, ve spodní části náběžná hrana spodního profilu 

 

Obr. 49. Rozložení tlaku na povrchu zadního křídla – pohled seshora, profil spodního křídla 
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Obr. 50. Rozložení tlaku na povrchu horního křídla – pohled zespoda, profil spodního křídla 

a část přídavné klapky 

 

Obr. 51. Rozložení tlaku na povrchu zadního křídla – pohled zespoda, profil horního křídla 
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Obr. 52. Vizualizace trajektorií proudu procházejícími zadním křídlem, patrný nárůst 

rychlosti mezi profily horního a spodního křídla 

 

Obr. 53. Vizualizace trajektorií proudu v rovině symetrie zadního křídla, patrný vznik 

Venturiho efektu 
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Obr. 54. Vektorové znázornění rychlosti proudu v rovině symetrie zadního křídla, patrné 

maximum na spodní straně náběžné hrany horního křídla, minimum pak na horní straně 

náběžné hrany přídavné klapky 

 

Obr. 55. Skalární pole znázorňující velikost rychlosti v rovině symetrie zadního křídla 
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7.3 Přesunutí tlumiče výfuku do oblasti převodovky 

Z důvodu vhodného umístění zadního křídla bylo nutné přesunout tlumič výfuku do niţší 

polohy, konkrétně do oblasti umístění převodovky. Původní tlumič byl z důvodu zachování 

symetrie modelu nahrazen dvěma menšími tlumiči. Jednotlivá uspořádání jsou patrná 

z obrázku 56. 

 

Obr. 56. Nahrazení původního tlumiče výfuku dvěma menšími v oblasti převodovky  
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8. Vytvoření CFD modelu vozidla s přídavnými 

aerodynamickými prvky 

Postup vytvoření modifikovaného CFD modelu, tedy modelu vozidla s přídavnými 

aerodynamickými plochami, je shodný s postupem vytvoření základního modelu. Jediným 

rozdílem je problémové síťování křídel, kdy dochází k přeskočení sítě z horního povrchu na 

spodní v blízkosti úběţné hrany. Tento defekt způsobuje nástroj na opravu sítě, bez kterého 

nelze bohuţel model vysíťovat. Řešením tohoto problému je seříznutí úběţné hrany, tedy 

vytvoření další plochy a nadefinování velikosti elementu menší neţ je výška této plochy. 

Seříznutí hrany s povrchovou sítí je zřejmé z obrázku 57. 

 

Obr. 57. Seříznutá úběžná hrana zadního křídla s povrchovou sítí, výška vzniklé plochy měří 5 

mm. 
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9. Výpočet a zhodnocení výsledků modelu s přídavnými 

aerodynamickými plochami 

Podobně jako u předcházejících modelů bez přídavných aerodynamických prvků, tak i u 

modelu s přídavnými aerodynamickými prvky byla data získána simulací proudění v softwaru 

Adapco Star CCM+. Výsledné hodnoty aerodynamických sil a momentu klonění jsou 

uvedeny v tabulce 11 a vztaţeny vůči souřadnému systému popsanému v kapitole 2. Záporná 

hodnota koeficientu vztlaku cz znamená, ţe se jedná o přítlak. 

 

Název modelu FX [N] FZ [N] MY [Nm] CX CZ A [m2] 

Formule Ford modifikovaná -815,7 -1528,5 -233,3 0,592 -1,11 0,931 

Tab. 11. Výsledné hodnoty silového a momentového zatížení s koeficienty aerodynamického 

odporu a vztlaku CFD modelu s přídavnými aerodynamickými prvky 

Výsledky rozloţení tlaku na povrchu vozidla s přídavnými aerodynamickými prvky a 

vizualizace proudnic jsou zobrazeny na obrázcích 58 – 68. Pro tyto obrázky platí stejné 

vlastnosti vzduchu jako pro vozidlo bez přídavných aerodynamických prvků uvedené v tab. 7 

v kapitole 6. 

 

Obr. 58. Rozložení tlaku na povrchu vozidla s přídavnými aerodynamickými prvky – čelní 

pohled, perspektiva, vizualizace trajektorií proudu, jejichž počátek leží ve výšce náběžné 

hrany předního křídla, vířivé proudy za vozidlem 
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Obr. 59. Rozložení tlaku na povrchu vozidla s přídavnými aerodynamickými prvky – čelní 

pohled 

 

Obr. 60. Rozložení tlaku na povrchu vozidla s přídavnými aerodynamickými prvky – zadní 

pohled v perspektivě, vizualizace vzniku vírů za vozidlem 
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Obr. 61. Rozložení tlaku na povrchu vozidla s přídavnými aerodynamickými prvky – pohled 

seshora 

 

Obr. 62. Rozložení tlaku na povrchu vozidla s přídavnými aerodynamickými prvky – pohled 

seshora, rozložení tlaku v rovině vozovky 
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Obr. 63. Rozložení tlaku na povrchu vozidla s přídavnými aerodynamickými prvky – pohled 

zleva 

 

Obr. 64. Rozložení tlaku na povrchu vozidla s přídavnými aerodynamickými prvky – pohled 

zleva, rozložení tlaku v rovině symetrie 
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Obr. 65. Rozložení tlaku na povrchu vozidla s přídavnými aerodynamickými prvky – pohled 

seshora, vizualizace trajektorií proudu, jejichž počátek leží ve výšce náběžné hrany předního 

křídla 

 

Obr. 66. Rozložení tlaku na povrchu vozidla s přídavnými aerodynamickými prvky – pohled 

zleva, vizualizace trajektorií proudu, jejichž počátek leží v rovině symetrie vozidla 
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Obr. 67. Rozložení tlaku na povrchu vozidla s přídavnými aerodynamickými prvky – čelní 

pohled v perspektivě, vizualizace trajektorií proudu, jejichž počátek leží ve výšce náběžné 

hrany předního křídla 

 

Obr. 68. Rozložení tlaku na povrchu vozidla s přídavnými aerodynamickými prvky – šikmý 

pohled v perspektivě, rozložení tlaku v rovině vozovky a vizualizace trajektorií proudu, jejichž 

počátek leží ve výšce náběžné hrany předního křídla 
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9.1 Výpočet reakcí od aerodynamických účinků na nápravách modelu 

vozidla s přídavnými aerodynamickými prvky 

Rozvor vozidla:        2400l mm  

Vzdálenost zadní nápravy od těţiště:      919zl mm  

Výška těţiště:         250h mm  

Hmotnost vozidla s jezdcem:       513m kg  

Aerodynamická odporová síla:      815,71XF N
 

Aerodynamická vztlaková síla:      1528,5ZF N 
 

Aerodynamický moment klonění:      233,3YM Nm   

Soustava rovnic pro výpočet silových reakcí: 

 

 

2
yT y X Z z

yTz
Zp Z G x

yTz
Zp Z G x

l
M M F h F l
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l l l

Ml l h
F F F F

l l l

 
      

 

      


      

 

Výsledná celková reakce vozovky na přední nápravě:   2593,1ZpF N

 Výsledná celková reakce vozovky na zadní nápravě:   3965,4ZzF N

 Procentuální zatíţení přední nápravy:     % 39,54%ZpF   

Procentuální zatíţení zadní nápravy:      % 60,46%ZzF   

Reakce vozovky od aerodynamických sil na přední nápravě:  667,1
AEROZpF N

 Reakce vozovky od aerodynamických sil na zadní nápravě:  861,5
AEROZzF N

  Název modelu Fzp [N] Fzz [N] %Fzp %Fzz FZpAero [N] FZzAero [N] 

Formule Ford modifikovaná 2593,1 3965,4 39,54 60,46 667,1 861,5 

Tab. 12. Vypočtené hodnoty celkového a aerodynamického zatížení modelu formule 

s přídavnými aerodynamickými prvky 
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 Graf 7. Porovnání výsledků statického a celkového zatížení na přední a zadní nápravě 

 

Graf 8. Porovnání podílu aerodynamické a tíhové síly zatěžující přední a zadní nápravu 
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Graf 9. Rozložení reakcí na přední a zadní nápravě od jednotlivých složek a od celkového 

zatížení 

Z výsledků získaných simulací výpočtů proudění a přepočtem reakcí vozovky v místě styku 

s pneumatikami vyplívá, ţe více je zatíţená zadní náprava, a to jak při nulové rychlosti, tak i 

při rychlosti 180 km/h. Z celkového zatíţení přední nápravy činí statické zatíţení (zatíţení 

tíhovou silou) 74,2% a aerodynamické zatíţení 25,8%. Na zadní nápravě je výsledek 

podobný, a to tak ţe statické zatíţení činí 78,2% a zatíţení aerodynamickými silami pak 

21,8%. Rozloţení celkového zatíţení odpovídá 39,5% na přední a 60,5% na zadní nápravě. 

9.2 Porovnání výsledků modelu s přídavnými aerodynamickými 

plochami s měřenými hodnotami vozu stejné kategorie 

Data získaná simulací proudění vzduchu okolo formule s přídavnými aerodynamickými prvky 

nebylo moţno porovnat s ţádným měřením z aerodynamického tunelu, popř. z dojezdové 

zkoušky, protoţe toto vozidlo reálně neexistuje a není k dispozici ani jeho reálný model. 

K porovnání tedy poslouţila data získaná z měření vozidel stejné kategorie, proto toto 

srovnání, stejně jako u předchozích modelů, nelze povaţovat za směrodatné, ale pouze za 

orientační. 

Z obrázku 33 v kapitole 6.2 je zřejmé, ţe modelovaná formule Ford s přídavnými 

aerodynamickými prvky je nejvíce podobná formuli číslo 7, jejíţ hodnota koeficientu 

aerodynamického odporu je 1,1 a hodnota koeficientu aerodynamického vztlaku je -0,95. 

Porovnáním těchto hodnot s daty získanými simulací se nejvíce podobají hodnoty koeficientu 

aerodynamického vztlaku. Hodnota koeficientu aerodynamického odporu získaná měřením je 

přibliţně dvakrát vyšší neţ hodnota získaná simulací. Jelikoţ je toto srovnání velmi hrubé, 

nelze zcela jasně posoudit kvalitu výsledků získaných simulací. 
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10. Porovnání výsledků modelu původního vozidla s modelem 

s přídavnými aerodynamickými plochami 

K porovnání výsledků modelů původního vozidla s vozidlem s přídavnými aerodynamickými 

prvky poslouţil model se stejnými okrajovými podmínkami, tedy formule Ford s rotujícími 

koly a průchozím chlazením a sáním. Obě varianty modelů jsou porovnány jak rozloţením 

tlaku na následujících obrázcích, tak i vypočtenými hodnotami zatíţení náprav zobrazených 

v grafech 10 – 12. 

 

Obr. 69. Rozložení tlaku na povrchu vozidla bez přídavných aerodynamických prvků 

 

Obr. 70. Rozložení tlaku na povrchu vozidla s přídavnými aerodynamickými prvky 
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Graf 10. Zatížení předních a zadních náprav modelu bez a s přídavnými aerodynamickými 

prvky 

 

Graf 11. Rozložení celkového zatížení na nápravách modelu bez a s přídavnými 

aerodynamickými prvky 
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Graf 12. Porovnání tíhového a aerodynamického zatížení modelu bez a s přídavnými 

aerodynamickými prvky 

Ze získaných výpočtů plyne navýšení celkového zatíţení náprav vlivem přídavných 

aerodynamických prvků o 35,4% oproti původnímu modelu. Původním vozidlo bylo 

aerodynamickými silami nadlehčováno, zatímco vozidlo s přídavnými aerodynamickými 

prvky je těmito silami značně přitěţováno. Podíl aerodynamického zatíţení na celkovém 

zatíţení modifikovaného vozidla je 23,3%, coţ je patrné z grafu 12.  
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11. Ovlivnění rozložení tlaku na površích křídel přítomností 

karoserie vozidla 

 

Obr. 71. Rozložení tlaku v rovině symetrie zadního křídla, model bez přítomnosti karoserie 

vozidla 

 

Obr. 72. Rozložení tlaku v rovině symetrie zadního křídla, model s karoserií vozidla 



Ústav automobilního  Jan Vančura 

a dopravního inženýrství 

 

 

Brno, 2008  74 

 

 

DIPLOMOVÁ PRÁCE 

 

Obr. 73. Rozložení tlaku v rovině řezu předním křídlem, model bez karoserie vozidla 

 

Obr. 74. Rozložení tlaku v rovině řezu předním křídlem, model s karoserií vozidla 

Z předcházejících obrázků je patrné, ţe karoserie vozidla ovlivňuje rozloţení tlaku na povrchu 

přítlačných křídel, a má tedy vliv na vyuţití přítlaku jednotlivých přídavných 

aerodynamických prvků. U zadního křídla ovlivnila karoserie rozloţení tlaku nepatrně, 

zatímco u předního lze hovořit o razantní změně. Samostatné křídlo má na spodní straně 

mnohem vyšší podtlak, přesunuly se i místa přechodu z podtlaku do přetlaku v oblasti 

koncových desek. Přítomnost špice automobilu má pak za následek charakteristický tvar 

rozloţení tlaku v rovině řezu předním křídlem.  
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12. Závěr 

Cílem této diplomové práce bylo vytvoření postupu pro sestavení CFD modelu závodního 

automobilu pomocí dat získaných měřením optickým 3D scannerem reálného vozu za účelem 

získání aerodynamických charakteristik závodního automobilu s nekrytými koly. Těţištěm 

prací vykonaných v rámci této diplomové práce byly studie vlivu aerodynamických prvků a 

nastavení okrajových podmínek na celkové zatíţení vozidla. Ze získaných dat zatíţení vozidla 

aerodynamickými silami byla následně provedena optimalizace tvaru karoserie s cílem 

navýšení zatíţení v místě styku pneumatiky s vozovkou. 

Z hlediska získání dat 3D scannerem se ukázalo jako nevhodné skenování jednotlivých dílů 

karoserie v rozebraném stavu, a to z důvodu deformace tvaru pruţných částí, coţ mělo za 

následek problematické sestavení dílů CAD modelu. Výsledná kvalita tvaru karoserie CAD 

modelu byla pro daný úkol dostatečně vysoká, coţ bylo ověřeno přeměřením základních 

rozměrů reálného automobilu v sestaveném stavu. 

Pro výpočet CFD modelu závodního automobilu s původní neoptimalizovanou karoserií byly 

vytvořeny tři varianty modelu s různými nastaveními okrajových podmínek. Díky těmto 

simulacím byl zjištěn vliv rotujících kol a průchozího chlazení na celkové zatíţení závodního 

automobilu aerodynamickými silami. 

Dále bylo provedeno několik simulací proudění vzduchu kolem pěti variant předních 

přítlačných křídel s cílem získání závislosti koeficientu přítlaku na vzdálenosti křídla od 

vozovky. Výpočet proudění kolem zadního křídla byl proveden pouze jeden z důvodu 

dostatečného zatíţení zadní nápravy. 

Tato úvodní studie splnila veškeré poţadavky kladené vedoucím diplomové práce v zadání. 

Navíc bylo provedeno několik simulací pro ověření vlivu přítomnosti karoserie na 

aerodynamické charakteristiky přítlačných křídel.  

Na základě získaných výsledků lze konstatovat, ţe byla vytvořena metoda pro získání dat 

zatíţení aerodynamickými silami, kterou lze opakovaně aplikovat na různých vozidlech. 

V této práci lze pokračovat více směry. Základním tématem pro rozvíjení znalostí z oboru 

aerodynamiky na Ústavu automobilního a dopravního inţenýrství a pokračování této úvodní 

studie, by mělo být zajištění verifikace výsledků získaných simulací pomocí měření, a to buď 

v aerodynamickém tunelu na reálném vozidle nebo jeho zmenšeném modelu, nebo alespoň 

pomocí dojezdové zkoušky. Další moţností pro pokračování jsou simulace proudění kolem 

automobilu s různým nastavením podvozku, konkrétně výšky podlahy od vozovky a úhlu 

náběhu. Konečným cílem by mělo být propojení CFD výpočtů a MBS simulací za účelem 

zvýšení kvality klasifikace jízdní stability automobilu. 
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Seznam použitých jednotek a veličin 

 

θ [°] úhel odtrţení přilnutého proudění na kolech automobilu 

μ [Ns/m
2
] dynamická viskozita 

ρ [Kg/m
3
] hustota 

cx [-] koeficient odporu 

cz [-] koeficient vztlaku 

Fx [N] aerodynamický odpor 

Fs [N] smyková síla 

Fy [N] aerodynamická boční síla 

Fz [N] aerodynamický vztlak 

Fzp [N] vztlaková síla na přední nápravě 

Fzz [N] vztlaková síla na zadní nápravě 

FZp [N] výsledná reakce vozovky na přední nápravě 

FZz [N] výsledná reakce vozovky na zadní nápravě 

FZpAero [N] výsledné zatíţení přední nápravy aerodynamickými silami 

FZzAero [N] výsledné zatíţení zadní nápravy aerodynamickými silami 

h [mm] výška těţiště 

l [mm] rozvor vozidla 
lz [mm] vzdálenost zadní nápravy od těţiště 

m [kg] hmotnost vozidla s jezdcem 
Mx [Nm] moment klopení 

My [Nm] moment klonění 

Mz [Nm] moment stáčení 

MyT [Nm] moment klonění v těţišti 

p [Pa] tlak 
r [mm] rozchod kol 

t [°C] teplota 

V [m/s] rychlost 

V∞ [m/s] rychlost volného proudu 

   

   

   

   

   

   

   

   

   

   

 


